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—. tH3X15%BB (Foreword)

1.1 EHSH (Suitable Condition)

T El/Tools I kR4S /Manufacturer Revision & AELE 2B /Applicable Module Type
UEMonitor AT+CGMR/Hi2115_ RFxx BC28/BC35G/BC95/BC68/BCI5G

1.2 #8XTF%% (Related to Download)

https://quectel123-my.sharepoint.cn/:u:/g/personal/ae-

UEMonitor i
fae_dom_quectel_com_cn/ERfHTcB_6eVEnD_540j1HVABIR3ZF6Cpst9asPdv)7-law?e=crS1n6

https://quectel123-my.sharepoint.cn/:u:/g/personal/ae-

TE-B Driver
fae_dom_quectel_com_cn/ESNgJMjMjyxGkHKOUyDj2hMBgaJnKVLQImm18qw22ejfTw?e=CTv5k8

1.3 iREEIE (Device Connection)

SNSRARHESERNE A BT EIRXHRAHI TR, BINSE TEEEL %R UEMonitor FTEY log;
If the module has been welded or debugged separately, it is recommended that you connect to the UEMonitor and grab the

log as shown below.

DBG_TXD
DBG_RXD
ND

DBG_TXD -> TTL:RX
DBG_RXD - TTL:TX
GND - TTL:GND

UEMonitor
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DBG_TXD - TTL:RX
DBG_RXD - TTL:TX
GND - TTL:GND

R0
BC35G o= UEMonitor

OR BC95G
BC95

DBG_RXD

UNER{EM Hi2115 HEAXINAY TE-B, 57 "SR ETRE—~I" HRE "/ coM i (XR21V1412 USB UARTCh B);

If TE-B corresponding to Hi2115 module is used, from “Device Manager - Ports” to select the second COM port(XR21V1412

USB UART Ch B).

—. UEMonitor &%t (Installation)

B EIARERE T EL Histudio 38, FRFSENRRIREHITREE, T&/5 Histudio BRI
Download the HiStudio installation package from the above link and select an appropriate installation path. After the

installation, the HiStudio icon is as follows.

:_Ll EMaonitor

UEMonitor icon

TR, NRZEEAMEHINEMEERR, BREZENEEE L% Microsoft .NET Framework, &3t FENX
{4HY setup.exe;

Before installing HiStudio, you need to install “Microsoft .NET Framework” (4.7.2 or later version, which can be downloaded

online) on the PC; Or install setup.exe in the downloaded file.

=. UEMonitor i&#% (Connection)

By EAREHRER) UEMonitor, BEEYIMEmIENITEREO, BEREXHEER;
Start UEMonitor through the above icon, and then the following window is displayed after initial startup. You can directly
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close the popup window;

UE Menitor (3.30.0.7) - 8 X
File Search Layout Charts Filters/Views Options Help

Messages A g

Details Status Msc FSM AT terminal MNotes 9

Filter: ~ default - View: | default - 5

i

© y 2

Index Time Message 5

5

5.

(=}

)

£

o

WA Tip OFf The Day — O x

You can change the format of message timestamps by right-clicking on a a message in the summary view and
selecting "Time format..."

[v] Show tips when UeMonitor starts up Mext tip...

Project Message Count: 0

1BIdSEERF="File—New Project—From UE debug port”,%#% Debug ix [, FESAINAEBREERATEY.xml/ fwpkg

X4, EREALARERZRESMIRINE &R, W TEFR;
On the menu bar "File->New Project->From UE Debug Port", select the debug port and import the.xml/.fwpkg File in the
corresponding module firmware version. At the same time, you can also create the corresponding test project name as

required, as shown below.

UE Monitor (3.30.0.7) - 0 x
Search Layout Charts Filters/Views Options Help
New Project —
@
Open Project From log file Details Status Msc FSM AT terminal Motes g
i o FIITEr | WETawT - View: | default - @ g
Change Message Definitions For Project ]
Save As... -
o
Export K
=.
3
Exit u;:
=3
o
&

Project Message Count: 0
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UE Monitor (3.30.0.7) - 9 x
File Search Layout Charts Filters/Views Options Help
Messages g
Details Status Msc FSM AT terminal Motes 9
Filter: - View: | default - g
E
© &
Index Time Message 5
El
S
(=}
El
£
o
&
New project from debug port Doy g Port
Serial port: COM4
Use message definitions from xml or fwpkg:
{ | E:\Firmware\BC28JARD2A02_ONT\messages.xml
Project name:
test |
Project Message Count: 0
test1 - UE Monitor (3.30.0.7) - 9 x
File Search Layout Charts Filters/Views Live Options Help
Messages Details Status Msc FSM AT terminal MNotes g
default - View: | default - g
® 4 LL1_ENTER_LOW_POWER_MODE index 341 at 00:00:18.3031010 ]
Transport &
Index Time Message header 5
317 00:18.157929  LL1_IDLE_MEAS_STATUS_LOG g-
318 00:18.158020 LL1_LOG_CURRENT_TIME_CALC t;
319 00:18,158142  LL1_IDLE_MEAS_STATUS_LOG E
&

320 00:18.212403  LL1_LOG_CURRENT_TIME_CALC

322 00:18.230286 LL1_NRS_MEASUREMENT_LOG

323 00:12.230378  LL1_PAGING_STATS_DATA

324 00:18.230489  LL1_LOG_CURRENT_TIME_CALC

325 00:18.230530  LL1_CALC_PAGING_DATA

326 00:12.230652  LL1_CONTEXT_SWITCH_MCELL

327 00:18.231141  LL1_IDLE_MEAS_STATUS_LOG

328 00:18.297669 LL1_RESYMNC

329 00:18.287791  LL1_NCELL_MEASUREMENT_LOG

330 00:18.297821  LL1_CONTEXT_SWITCH_SCELL

EE)| 00:18.298066  LL1_IDLE_MEAS_STATUS_LOG

3312 00:12.288157  LL1_LOG_CURRENT_TIME_CALC

333 00:18.298249  LL1_IDLE_MEAS_STATUS_LOG

334 00:18.298371  LL1_INTRA_FREQ_MEAS_IND

335 00:12.298645 RRC_DBG_RESELECTION_CANDIDATES
336 00:18.298645  LL1_SERVING_CELL_MEAS_IND

37 00:18.298737 RRC_DBG_CELL_S_CRITERIA

338 00:12.300538 RRC_DBG_RESELECTION_CANDIDATES
339 00:18.302613  LL1_LOG_CURRENT_TIME_CALC

340 00:18.302735  LL1_IDLE_MEAS_STATUS_LOG

321 00:18.230256  PROTO_LL1_SERVING_CELL_MEASUREMENT_IND

+ Auto-scroll

Project testl

UEMonitor tB373F AT BOREIESHITHEXRSESL, WTEFFx;

Idle: 0:00:00  Message Count: 343

UEMonitor also supports AT serial port to send commands for relevant synchronous debugging, as shown below.
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test] - UE Monitor (3.30.0.7) o B &
File Search Layout Charts Filters/Views Live Options Help

Messages @

Details Status Msc FSM | AT terminal | Notes 9

Filter: | default - View: | default - @ 5

® comMs - Opened Send file... Clear &

&

[

l UART Port .

Index Time Message ATI 5

2670 02:44.146424  LL1_LOG_CURRENT_TIME_CALC g.

2671 02:44.158997  PROTO_LL1_SERVING_CELL_MEASUREMEMT_IND t;

2672 02:44,159027  LL1_NRS_MEASUREMENT_LOG E

1

2672 02:44.159302 LL1_DCI_FORMAT_N2_PAGING oK
2674 02:44.163880 LL1_MRS_MEASUREMENT LOG

2675 0244164124 LL1_LOG_CURRENT_TIME_CALC

2676 02:44.164185 LL1_CALC_PAGING_DATA

2677 02:44.164338 LL1_CONTEXT_SWITCH_MCELL

2678 02:44,164856 LL1_IDLE_MEAS_STATUS_LOG

2678 02:44.164887 LL1_PAGE_IND

2680 02:44.165039 RRC_DEBUG_ASN

2681 02:44,165192 RRC_DBG_DL_ASN_MSG_MEM_ALLOC_INFO
2682 02:44.220551 LOG_STACK_FIRMWARE_VERSION_STRING_CNF
2683 02:44.241791 LL1_RESYNC

2684 0244241913 LL1_NCELL_MEASUREMENT_LOG

2685 02:44.241944 LL1_CONTEXT_SWITCH_SCELL

2636 02:44.242157 LL1_IDLE_MEAS STATUS_LOG

2687 02:44.242249 LL1_LOG_CURRENT_TIME_CALC

2688 02:44.242371 LL1_IDLE_MEAS_STATUS_LOG

2638 02:44.242645 LL1_ENTER_LOW_POWER_ MODE

2600 02:44.242645 LL1_INTRA_FREQ_MEAS_IND

2691 02:44.242890 RRC_DBG_RESELECTION_CANDIDATES

2692 02:44.242830 LL1_SERVING_CELL_MEAS_IND

2603 02:44,242981 RRC_DBG_CELL_S_CRITERIA input AT Command then press Enter

'
+ Auto-scroll ’ ‘ |

Project testl

BIgSE=" Live—Disconnect/Pause” Wi FR &nEE =1L, W TERR,;

By "Live->Disconnect/Pause" in the menu bar to disconnect or stop the device, as shown below.

test - UE Monitor (3.30.0.7) = @ =
File Search Layout Charts FiItersNiews Options Help
Messages Details Status Msc FSM AT terminal Notes Egn
Filter: - View: | default - z
@ 4 LL1_LOG_CURRENT_TIME_CALC index 3497 at 00:00:33.7672380 B
© Transport "
Index Time Message " header g
373 033538112 LLI_NRS_MEASUREMENTLOG f_tick_ref 1146115704 g
3474 00:33.538204 LL1_LOG_CURRENT_TIME_CALC rf_tick_cur 1147672851 =)
3475 00:33.558101 LL1_NRS_MEASUREMENT LOG frames_elapsed 4 =
3476 033556224 LL1_LOG_CURRENT_TIME_CALC hin ref 1005 .
3477 00:33.574388 LL1_NRS_MEASUREMENT_LOG fn ref 58
3478 00:33.574550 LL1_LOG_CURRENT_TIME_CALC ity cur 1005
3479 0:33607113  LL1_NRS_MEASUREMENT_LOG -
3480 00:33.607235 LL1_LOG_CURRENT_TIME_CALC sfn_cur 2
sf cur 0

3481 00:33.618099 LL1_NRS_ MEASUREMENT LOG
3482 0033618221 LL1_LOG_CURRENT_TIME_CALC sf_ref 0
3483 00:33.638112 LL1_NRS_ MEASUREMENT LOG
3484 00:33.638241 LL1_LOG_CURRENT_TIME_CALC
3485 00:33.654415 LL1_NRS_MEASUREMENT_LOG
3486 00:33.654306 LL1_LOG_CURRENT TIME_CALC
3487 00:33.687130 LL1_NRS_ MEASUREMENT LOG
3488 00:33.687252 LL1_LOG_CURRENT_TIME_CALC
3489 00:33.698116 LL1_NRS_ MEASUREMENT LOG
3490 00:33.698208 LL1_LOG_CURRENT TIME_CALC
3491 00:33.718105 PROTO_LL1_SERVING_CELL_MEASUREMENT_IND
3492 00:33.718166 LL1_NRS_ MEASUREMENT LOG
3493 00:33.718288 LL1_LOG_CURRENT_TIME_CALC
3494 0033734432 LL1_NRS_MEASUREMENT_LOG
3495 00:33.734354 LL1_LOG_CURRENT_TIME_CALC
3496 00:33.767147 LL1_NRS_MEASUREMENT LOG

v Auto-scroll

Project test 3513

. BEFEF (Save Log)

4.1 B@lRTF(Automatically Save)

UEMonitor L 5B R FE . KB K 06 BB MR EFE” FE B 31 \UeMonitor\Projects” H (C:\Users\xxx
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\Documents\UeMonitor\Projects)

UEMonitor supports automatic saving, The obtained logs are automatically saved in the "C:\Users\ XXX \Documents\

UEMonitor \Projects ".

4.2 Fu)RTFE(Manual save)

tBET LA File— Export " {ESEE PR SH SR F RS X2 FREIE], W TERR;
You can also select the Export path and the name of the compressed File in the popup window from the menu bar

"File>Export", as shown below.

TEST - UE Monitor (3.30.0.7) -9 %
File Search Layout Charts Filters/Views Live Options Help
Messages ~ 0 Details Status Msc FSM AT terminal Motes g'::
Fiter: ~ default v View | default - ‘ 5
4 LL1_CONTEXT_SWITCH_SCELL index 169 at 00:00:10.2246710 ]
@ v Transport &
Index  Time Message header 2
154 00:10.084395  LL1_NCELL_MEASUREMENT_LOG earfen 3688 %
155 00:10.084626  LL1_CONTEXT_SWITCH_SCELL phy_cell id 121 =
156 00:10.084778  LL1_IDLE_MEAS_STATUS_LOG =
157 00:10.084870  LL1_LOG_CURRENT_TIME_CALC v
158 00:10.084992  LL1_IDLE_MEAS_STATUS_LOG
159 00:10.128357  LL1_LOG_CURRENT_TIME_CALC Export Project H
160 00:10.156730  PROTO_LL1_SERVING_CELL_MEAS... Project Name TEST
161 00:10.156769  LL1_NRS_MEASUREMENT_LOG )
16 0010156691 L1 PAGING,STATS, DATA Export Directory Ci\Usersiherbert.pan\Desktop “]
163 00:10.156983  LL1_LOG_CURRENT_TIME_CALC FipFileName [testt] ]
164 00:10.157044  LL1_CALC_PAGING_DATA :
165 00:10.157125  LL1_CONTEXT_SWITCH_MCELL Export Cancel
166 00:10.157654  LL1_IDLE_MEAS_STATUS_LOG ( 7 )
167 00:10.224518  LL1_RESYNC 7 5
168 00:10.2246840 LL1_NCELL_MEASUREMENT LOG
170 00:10.224854  LL1_IDLE_MEAS_STATUS_LOG
7 00:10.224946  LL1_LOG_CURRENT_TIME_CALC
172 00:10.225068  LL1_IDLE_MEAS_STATUS_LOG
173 00:10.225312  LL1_ENTER_LOW_POWER_MODE
174 00:10.225212  LL1_INTRA_FREQ_MEAS_IND
175 00:10.225556  RRC_DBG_RESELECTION_CANDID...
176 00:10.225556  LL1_SERVING_CELL_MEAS_IND
177 00:10.225647 RRC_DBG_CELL_S_CRITERIA
178 00:10.227417 RRC_DBG_RESELECTION_CANDID...
Auto-scroll
Project TEST DISCONMECTED  Message Count: 179

NSRBI File—Save As"FHESSERGIIIIE BFRG, Log {APARTFE"FHAYSIAE\UeMonitor\Projects” H3(C:\Users\xxx
\Documents\UeMonitor\Projects)
If you use the menu bar "File>Save As" and fill in the name of the test project, the Log is still saved in “C:\Users\ XXX

\Documents\UeMonitor\Projects”.
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TEST - UE Monitor (3.30.0.7) = @ &
File Search Layout Charts Filters/Views Live Options Help
Messages ¥ 0 Details Status Msc FSM AT terminal Notes Egn
Filter: = default - View: | default - ‘ 5
4 |11_CONTEXT_SWITCH_SCELL index 169 at 00:00:10.2246710 B
@ Transport &
Index Time Message header E
154 00:10.084595  LL1_NCELL_MEASUREMENT LOG earfen 3688 ]
155 00:10.084626  LL1_CONTEXT SWITCH_SCELL phy_cell_id 121 =)
156 00:10.084778  LL1_IDLE_MEAS_STATUS_LOG =
157 00:10:024870  LL1_LOG_CURRENT_TIME_CALC "
158 00:10:084992  LL1_IDLE_MEAS_STATUS_LOG
159 00:10.128357  LL1_LOG_CURRENT_TIME_CALC X
160 00:10.156730  PROTO_LL1_SERVING_CELL_MEAS. . Save Project As... a
161 00:10.156760  LL1_NRS_MEASUREMENT LOG Project Name [ test]] |
162 00:10.156891  LL1_PAGING_STATS_DATA
163 00:10.156983  LL1_LOG_CURRENT_TIME_CALC Ok
164 00:10.157044  LL1_CALC_PAGING_DATA
165 00:10.157135  LL1_CONTEXT_SWITCH_NCELL
166 00:10.157654  LL1_IDLE_MEAS _STATUS LOG
167 00:10.224518  LL1_RESYNC
168 00:10.224640  LL1_NCELL_MEASUREMENT_LOG
170 00:10.224854  LL1_IDLE_MEAS_STATUS_LOG
17 00:10.224946  LL1_LOG_CURRENT_TIME_CALC
172 00:10.225068  LL1_IDLE_MEAS _STATUS LOG
173 00:10.225312  LL1_ENTER_LOW_POWER_MODE
174 00:10.225312  LL1_INTRA_FREQ_MEAS_IND
175 00:10.225556 RRC_DBG_RESELECTION_CANDID...
176 00:10.225556  LL1_SERVING_CELL_MEAS_IND
177 00:10.225647 RRC_DBG_CELL_S_CRITERIA
178 00:10.227417 RRC_DBG_RESELECTION_CANDID...
Auto-scroll
Project TEST DISCONNECTED ~ Message Count: 179

. ERSHRA (Common Analytical Application)

5.1 LOG & A (Import Log)

BEENEIENA] Log FAHAY raw.ued! SZ4EIAT, EiEid UEMonitor SZER4="File—From log file” SNTFHOHT Log 314
Y raw.uedl X4, SITER7R; WRBIETER, FTELTExml X, BolLABITIZ#EESAS R EGRE

BY.xm| ST TRENT; BB SEE 42 File—Change Message Definitions For Project” S AJT A xml SZ44;

Directly double-click the raw.uedl File in the captured Log File, or import the raw.uedl File in the Log File to be analyzed
through the UEMonitor menu bar "File>From Log File", as shown below. If parsing errors occur and you need to change
the. XML file, you can also import the. XML file of the corresponding firmware version through the pop-up window for

parsing. Or import the corresponding.xml File from the menu bar "File->Change Message Definitions For Project".
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UE Monitor (3.30.0.7) - 0 X
Search Layout Charts Filters/Views Options Help
New Project ‘
@
Open Project tus Msc FSM AT terminal Notes §
Change Message Definitions For Project ;
Save As... -
E =2
Export g
E
Exit o
[
o
R

Project Message Count: 0

UE Menitor (3.30.0.7) - 8 X
File Search Layout Charts Filters/Views Options Help

Messages Details Status Msc FSM AT terminal MNotes g

Fitter.  default - View: default - @ 5

i

© y 2

Index Time Message 5

El

S

(=}

)

£

o

&

New Project from log-file n
C\Users\herbert.pan\Desktop\log\20220505_E 41909 COM!

Project name: | Use a temporary project ‘

Use message definitions in log file

Use message definitions from xml or fwpkg:

E\Firmware\BC28JAR02A02_ONTymessages.xml |

o o

Project Message Count: 0

5.2 AY[EIZ=EZF (Time Reference System)

WTERFR, EEBEREL, A, &FETime”, ALRSRARRRESEER;

As shown below, in the main message window, right click and select "Time" to change different Time reference systems;

— Herbert Pan —




neEcrTer
UEMonitor I{FIES S55%

test] - UE Monitor (3.30.0.7)

File Search Layout Charts Filters/Views Live Options Help
Messages ~ % Details Status Msc FSM AT terminal MNotes Uga
Fitter: | dlefault + View: default - g
4 PDCP_DATA_IND index 584 at 00:00:10.8203700 ]
® ! Transport &
Index Time M o header g
lessage msq_type state direction  dl_count ulcount ul queue e
577 0010818813 LL1_RACH_CONTENTION.. pdcppdu a =
578 00:10.878905  LL1_HARQ_ACK_SENT : pdeppdu_len 29 =
5719 00:10,8189%6  LL1_PUSCH_CALC_TX_PQ... rb_id L2_SREO §
580 00:10.819688  LL1_RACH_CNF integrity_failure false
581 00:10.820064 MAC_UL_TO_DL_RACH_C...
582 00:10,820187  RLC_DL_DATA_IND
583 00:10.820370 MAC_UL_CRNTI_IND
Relative to start of trace
s26 001 Pin message in new tab Relative to this message
587 00:1 Date time (UTC)
Previous message of this type Shift-F2
588 00:1
s80 0011 Next message of this type F3
. Microseconds
380 00:1 Copy message name i
591 00:1 c ‘ d CrlsC Milliseconds
opy selectei trl+
392 00:1 C > hart for thi Seconds
: reate event chart for this message
3% a1 ¢ Hours, minutes, seconds
594 00:1 Export data..
%3 001 Calculate...
506 00:1
597 00:1 Set Bookmark Ctrl+B
Gt oo Add common field... 4
569 00: 16 o —
600 00:10.834652  PDCP_DATA_RECQ
Al »
Auto-scroll
Project testl ISCOMNECTED  Message Counf

5.3 LOG i (Filter Log)

1) KHEFIDiE(By Keyword):

MTERTR, EXEFBABORBAXEFS, UEMonitor BRNTIRAER, BERSHSNEL”| | ENILIE;

As shown below, after the input window input keywords, UEMonitor automatic filtering and display,

support double vertical bar "| |" regular type filter;

at the same time

TEMP_[Z7< 0940_raw_ 637875132148327921 - UE Monitor (3.30.0.7) > B 8
File Search Layout Charts Filters/Views Options Help
Messages T 0 Details Status Msc FSM AT terminal Notes é:;
Filter: | default - View: | default . 3
4 NAS_DBG_MAS_MSG index 390 at 00:01:09.1409630 < B
@[ DBG_NAS||PROTO_RRC|[PROTO_DATA||ASN I Transport &
index | Time Message header g
Com owwes wspcwsws drecton :
413 01:08.144106 PROTO_RRC_STATE_IND security_hdr EWIM_INTG_PROT_AND_PARTIALLY_CIPHERED l;
418 01:09.145510  RRC_DEBUG_ASN msg_type L3_EMM_CONTROL_PLAME_SERVICE_REQ 5=
538 01:09.376406  RRC_DEBUG_ASN len 85 -
560 01:09.390902  RRC_DEBUG_ASN data 7
366 07:08.391633  PROTO_RRC_STATE_IND Additional Info 07-4D-40-78-00-4B-52 -00-EB-00-46-FF-FF-FF-F
728 01:09.538882  RRC_DEBUG_ASN FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF:
731 01:09.538882  MAS_DBG_NAS_MSG FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-
737 01:09.538822  PROTO_DATA_STATS_IND FF-FF-FF-FF-FF-FF-FF-FF-57-02-20-00-00-01-00-(
836 01:09.630709 RRC_DEBUG_ASN
89 01:00.631869  NAS_DBG_NAS_MSG 074D4078004B5200EB0046FFFFFFFFFFFFFFFFFFFI
891 01:09.632052  PROTO_DATA_STATS_IND S e
2933 0115021255 RRC DEBUG ASN FFFFFFFFFFFFFFFFFFFFFFS7022000
- - MNASMessage:
4936 01:15.027255 MAS_DBG_NAS_MSG emmMessage:
4938 01:15.027255 PROTO_DATA_STATS_IND plain:
5101 01:15.212008 PROTO_DATA_STATS_IND protocolDiscriminator = 0x7
5106 01:15.212283 NAS_DBG_NAS_MSG securityHeaderType = 0x0
5109 01:13.213442  RRC_DEBUG_ASN messageType = Oxdd
5243 01:15.387911 PROTO_DATA_STATS_IND body:
547 0115387911 NAS_DBG_NAS_MSG controlPlaneServiceRequest:
5250 01:15.323705 RRC_DEBUG_ASN controlPlaneServiceType:
activeFlag = 0x0
5419 01:15553103 PROTO_DATA_STATS_IND controlPlaneServiceType = 00
5422 01:15533103 PROTO_DATA_STATS_IND naskeySetidentifier:
5644 01:15.235624 PROTO_DATA_STATS_IND typeOfSecurityContext = 0x0
5649 01:15.255624 MAS_DBG_NAS_MSG nasKeySetldentifier = 0x4 -
5651 01:15.836509 RRC_DEBUG_ASN “ v

Project TEMP__/&7%_0940_raw__637875132148327921

Message Ci 1860345

2) B (Find):
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TEFr=, e LUBIgSEE="Search—Find" {EBEEPMAEIER, nILAEF)/REES;

As shown below, you can also enter the query message in the popup window through the menu bar "Search->Find" to Search

forward/backward;
TEMP_E7<_0940_raw__637875132148327921 - UE Monitor (3.30.0.7) = B8 &
File Search Layout Charts Filters/Views Options Help
Messages T 1 Details Status Msc FSM AT terminal Notes Egn
Search Options n View: | default - @ )
4 NAS_DBG_NAS_MSG index 390 at 00:01:09.1409630 -
() b Nas|erom " Query | Text Transport f
Index Tim{ NAS DBG NAS MSG header g
I direction UL_PDU 3
113 01:09.1¢ A A% security_hdr EMIM_NTG_PROT_AND_PARTIALLY_CIPHERED pat
218 01:00.1¢ Previous Next msg_type 13 EMM_CONTROL_PLANE SERVICE_REQ) £
538 01:09.376806 RRC_DUEBUG_ASI len 85 "
560 01:00.390902  RRC_DEBUG_ASN data 7
66 01:09.391635 PROTO_RRC_STATEIND Additional Info 07-4D-40-78-00-4B-52-00-EB-00-46-FF-FF-FF-F
728 07:08.338882 RRC_DEBUG_ASN FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-
73 01:00.538882  MAS_DEG_NAS_MSG FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF
737 01:08.538882  PROTO_DATA_STATS_IND FF-FF-FF-FF-FF-FF-FF-FF-57-02-20-00-00-01-00-
T 01:00.630702  RRC_DEBUG_ASN
30 D1:09.631865  NAS_DRG_NAS MSG 0744075004852 00EB0046 FFFFFFFFFFFFFFFFFFFI
81 01:08.632052  PROTO_DATA_STATS_IND
4933 0115027255 RRC DEBUG ASN LF;?;:ZZF;FFFFFFFFFSmzzm
4936 0115027255 NAS_DBG_NAS_MSG emmiMessage:
4938 01:15027255 PROTO_DATA_STATS_IND plain:
S101 0115212008 PROTO_DATA STATS IND protocolDiscriminator = 0x7
5106 01:15.212283  MAS_DBEG_NAS_MSG securityHeaderType = 0x0
5108 01:15.213442  RRC_DEBUG_ASN messageType = Oxdd
5243 0115387911 PROTO_DATA STATS IND body:
5247 0115387911 MAS_DBG_NAS_MSG controlPlaneServiceRequest:
5250 0115388705 RRC_DEBUG_ASN controlPlaneserviceType:
activeFlag = 0x0
5419 0115553102 PROTO_DATA STATS IND controlPlanesenviceType = 0x0
5422 0115553103 PROTO_DATA STATS IND nasKeySetidentifier:
5644 0115855624 PROTO_DATA_STATSND typeOfSecurityContext = 0x0
5649 01:15.855624 MAS_DBG_MNAS_MSG naskeysetldentifier = Ox4 hd
5651 01:15.856500 RRC_DEBUG_ASN 1 5

Project TEMP_J&7_0840_raw__§37875132148327921

Message Count: 1860345

5.4 1ENNiEE5E(Add Item)

INTEFR, AAMNEO Details HEF, IBEMEFNEEEORIER, GF, AEREIERE Show insummary list

—This field from any message” BJA];

As shown in the figure below, in the Details message of the right window, select the message to be added to the main window,

right click, and select "Show in Summary list>This field from any message" in the pop-up window.

— Herbert Pan —
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File Search Layout Charts Filters/Views Options Help

Messages Details Status Msc FSM AT terminal Motes Uga
Filter: | default - View: | default - g
4 NAS_DBG NAS_MSG index 390 at 00:01:09.1409630 -8
() DBG_NAS|IPROTO_RRCI|PROTO_DATAI|ASN Transport &
Index Time Message header 5
S owewes wsoeNeswss arection u_pou
413 01:08.144106  PROTO_RRC_STATE_IND security_hdr EMM_INTG_PROT_AND_PARTIALLY_CIPHERED =
418 01:09.145510 RRC_DEBUG_ASN msg_type 13 ENM CONTROL PLANE SERVICE_REQ %
533 01:00.376406  RRC_DEBUG_ASN len Plot Chart v v
560 01:09.390902  RRC_DEBUG_ASN date
566 01:09.381635 PROTO_RRC_STATE_IND Apply as new filter
722 01:09.538222 RRC_DEBUG_ASN This field gFFEFFEFFEFF
73 01:00.538882  MAS_DEG_NAS_MSG Seard Ctrl+F L FF-FF-FF-FF-
737 01:08.538882  PROTO_DATA_STATS_IND Toggle Hex/Dec Ctri+X  10-00-01-00-
886 01:09.630709  RRC_DEBUG_ASN Custom format
289 01:00.631860  MAS_DEG_NAS_MSG FFFFFFFFFFFFI
831 01:08.632052 PROTO_DATA_STATS_IND Copy Ctrl+C FFFFFFFFFFFFI
4933 01:15.027255 RRC_DEBUG_ASN Copy value Shift+V
4936 0115027255 NAS_DBG_NAS_MSG Copy as filter Shift+F
4938 01:15027255 PROTO_DATA_STATS_IND Toggle in status window
5101 0115212008 PROTO_DATA_STATS IND ) . %7
5106 01:15.212283  MAS_DBG_NAS_MSG Go to message in summary list
5100 01:15.213442  RRC_DEBUG_ASN Copy full message details Shift+C
5243 0115387911 PROTO_DATA STATS IND Export Data . .
5247 0115387911 MAS_DBG_NAS_MSG uest:
5250 01:15.388705 RRC_DEBUG_ASN Set Color Rule ] ype
5419 0115553103 PROTO_DATA STATS IND P B
422 0115553103 PROTO_DATA_STATS IND na;;:;;; da:netiieer:mype = 0x0
5644 01:15.855624 PROTO_DATA_STATSND typesfsecurityContest = 0x0
5640 0115855624 MAS DEG_NAS MSG nasKeySetidentifier = 0x4 .
5651 01:15.856500 RRC_DEBUG_ASN . v
Project TEMP_J&7_0840_raw__§37875132148327921
TEMP_JE75_0940_raw__637875132148327921 - UE Monitor (3.30.0.7) = @ &
File Search Layout Charts Filters/Views Options Help
Messages T 1 Details Status Msc FSM AT terminal Notes Egn
Filter: | default - View: | default ‘ El
4 NAS_DBG_NAS_MSG index 390 at 00:01:09.1409630 -
()| DBG_NAS|IPROTO_RAC||PROTO_DATA/|ASN Transport =
Index Time Message msg_type header E
direction UL_PDU 3
13 01:09.144106 PROTO_RRC_STATE_IND security_hdr EMM_INTG_PROT_AND_PARTIALLY_CIPHERED l;
218 01:08.145510  RRC_DEBUG_ASN msg_type 13 EMM_CONTROL_PLANE SERVICE_REQ) 5
533 01:09.376406  RRC_DEBUG_ASN len 85 “
560 01:09.390902  RRC_DEBUG_ASN data 7
66 01:09.391635 PROTO_RRC_STATEIND Additional Info 07-4D-40-78-00-4B-52-00-EB-00-46-FF-FF-FF-F
728 07:08.338882 RRC_DEBUG_ASN FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-
73 01:00.538882  MAS_DEG_NAS_MSG L3_EMM_SERVICE_ACCERT FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF-FF
737 01:08.538882  PROTO_DATA_STATS_IND FF-FF-FF-FF-FF-FF-FF-FF-57-02-20-00-00-01-00-
T 01:00.630702  RRC_DEBUG_ASN
30 D1:09.631865  NAS_DRG_NAS MSG 13_ESM_DATA_TRANSPORT 0744075004852 00EB0046 FFFFFFFFFFFFFFFFFFFI

FFFFFFFFFFFFFFFFFFFFFFS7022000

g 01:09.632052  PROTO_DATA_STATS_IND

2933 01:15.027255 RRC_DEBUG_ASN
NASMessage:
4936 0115027255 NAS_DBG_NAS_MSG 13_ESM_DATA_TRANSPORT emmMessage:
4938 01:15.027255 PROTO_DATA_STATS_IND plain:
5101 01:15.212008 PROTO_DATA_STATS_IND protocolDiscriminator = 0x7
5106 01:15.212283  NAS_DBG_NAS_MSG 13_ESM_DATA_TRANSPORT securityHeaderType = 0x0
5108 01:15.213442  RRC_DEBUG_ASN messageType = Oxdd
523 01:1537911 PROTO_DATA_STATS IND body:
5247 0115387911 MAS_DEG_NAS_MSG L3_ESM_DATA_TRANSPORT controlPlaneServiceRequest:
5250 0115388705 RRC_DEBUG_ASN controlPlaneserviceType:
activeFlag = 0x0
5416 01:15.553103 PROTO_DATA_STATS IND controlplaneserviceType = 0x0
5422 01:15.553103 PROTO_DATA STATS IND naskeySetidentifier:
5644 0115855624 PROTO_DATA STATS_IND typeOfsecurityContext = 0x0
5646 01:15.855624  NAS_DBG_NAS_MSG L3 ESM_DATA,_TRANSPORT naskeySetldentifier = Ox4 =
5651 01:15.856500 RRC_DEBUG_ASN . v

Project TEMP_J&7_0840_raw__§37875132148327921

Message Cou 1860345

5.5 BB &E(Color the Message)

WTEFR, EAM Details BREBOTEL, fAih, EHEEFIEEE"Show in summary list—Set Color Rule”, FFifHE

EEHERE, STLARIARREZRE message [HEHITER,
As shown below, right click in the blank area of the right Details message window, select "Show in Summary List ->Set

Color Rule" in the popup window, and select the appropriate Color to Color different types of message.

— Herbert Pan —
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test1 - UE Monitor (3.30.0.7) = @ B
File Search Layout Charts Filters/Views Live Options Help
Messages Details Status Msc FSM AT terminal Motes Uga
Filter: | default - View: default - =
4 RRC_DEBUG_ASN index 585 at 00:00:10.8204920 -8
() DBG_NAS|IPROTO_RRCI|ASNPROTO_DATA Transport T
Index Time Message msqg_type state direction  dl_count  ul_cc header a
102 00:09.368709  PROTO_RRC_STATE_IND PROTO_RRC_NULL channel_type RRCASNDLCCCH | S
417 46 RRC_DEBUG_ASN message_type RRC_CONNECTION '
436 96 RRC_DEBUG_ASN len 29 £
443 00:10.120998  PROTO_RRC_STATE_IND PROTO_RRC_IDLE data 52 v
445 00:10.121120  PROTO_RRC_STATE_IND PROTO_RRC_IDLE additional Info DL-CCCH-Message
464 00:10.145046  MAS_DBG_NAS_MSG L3_EMM_ATTACH_REQ UL_PDU {
an 00:10.145840  PROTO_RRC_STATE_IND PROTO_RRC_CONMECTING message cl : rreC
478 42 RRC_DEBUG_ASN {
[ses oiomamea mRCOEBUGASN Plot Chart ’
597 D0:10.834347 RRC_DEBUG_ASN
601 00:10.834927  PROTO_RRC_STATE_IND PROTO_RRC_CONMECTED Apply as new filter
658 70852 RRC_DEBUG_ASN Show in summary list 3
661 00:10:971157 MAS_DBG_NAS_MSG L3_EMM_AUTH_REQ DL_PDU Search.. Ctrl+F
709 00:11.124560  NAS_DBG_NAS_MSG L3_EMM_AUTH_RSP UL_PDU Toggle Hex/Dec Cirlex
71 1124813 RRC_DEBUG_ASN
800 11427151 RRC_DERUG_ASN Custom format
804 00:11.427578  NAS_DBG_NAS_MSG L3_EMM_SECURITY_MODE_CMD DL_PDU Copy Cirl+C
807 00:11.430752  NAS_DBG_NAS_MSG L3_EMM_SECURITY_MODE_COMPLETE UL_PDU Copy value Shift+\/
e RRC_DEBUG_ASN Copy as filter Shift+F
911 687466 RRC_DEBUG_ASN Toggle in status window
914 00:11.687466  NAS_DBG_NAS_MSG L3_EMM_ATTACH_ACCEPT DL_PDU
220 NAS_DEG_NAS_MSG 13 EMM_ATTACH_COMPLETE UL_PDU Go to message in summary list
922 RRC_DEBUG_ASN Copy full message details Shift+C
993 RRC_DEBUG_ASN
Export Data 3
4 13
Auto-scroll ‘ Set Color Rule ]

Project test1 DISCOMNECTED  Message Count: 4800

5.6 EiTiEXEEZ(Common Filtering Keyword)

NAS message DBG_NAS]| |ASN
Search Network BOOT| | MAPPING| |SCAN| |EARFCN| |S_C] | Suitable
DATA PROTO_DATA| | PDCP_DATA| | ASN| | APPLICATION| |[DBG_N| | PDCP_DATA
ServingCell Serving_cell
S MIB|SIB|ASN

— Herbert Pan —
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